
Configuration Tutorial
Onboard Interface (OBI) and PC Interface (PCI)

for the Models SC22-3 and SC22-3E Safety Controller

Contents

Configuration Tutorial — PC Interface .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  Page 3 

Configuration Tutorial — Onboard Interface  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  Page 15

	 09/27/2010	 P/N 154613 rev. C



Banner Engineering Corp. • Minneapolis, U.S.A.
www.bannerengineering.com  •  Tel: 763.544.3164

SC22-3 and SC22-3E Safety Controller 
Configuration Tutorial

Important . . . read this before proceeding!
It is the responsibility of the machine designer, controls engineer, machine builder and/or maintenance electrician to apply and maintain this 
product in full compliance with all applicable regulations and standards. The product can provide the required safeguarding function only if 
it is properly installed, properly operated, and properly maintained. This manual attempts to provide complete installation, operational, and 
maintenance instruction. Reading the manual completely is highly recommended. Please direct any questions regarding the application or use 
of the product to the Banner Engineering Applications at the locations shown on the back cover.
For more information regarding U.S. and international institutions that provide safeguarding application and safeguarding product performance 
standards, see the list on the inside of the back cover.
Use of Warnings
Warnings are intended to remind the machine designer, control engineer, machine builder, maintenance electrician, or end user how to avoid 
misapplication of this product and effectively apply the Safety Controller to meet the various safeguarding application requirements. Reading 
and abiding by the warnings is highly recommended.

WARNING . . . User Responsibility
It is the responsibility of the qualified person who configures, installs, or maintains the Safety Controller to:

• �Carefully read, understand and follow the information in this manual.

• �Perform a risk assessment of the specific machine guarding application.

• �Determine what safeguarding devices and methods are appropriate per the requirements defined in ISO 13849-1 and other appropriate standards 
such as those that are referenced in this manual.

• �Create and confirm each configuration and then verify that the entire safeguarding system (including input devices and output devices) is 
operational and working as intended.

• �Periodically re-verify as needed, that the entire safeguarding system is working as intended.

Failure to follow any of these recommendations can potentially create a dangerous condition that may lead to serious injury or death.
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The PC-based User Interface (PCI) is the primary tool for 
creating and managing configuration files for the Safety 
Controller. It’s also used to retrieve, display and store both I/O 
and system status and fault information.

The following tutorial explains the steps needed to create a 
sample configuration, using the Safety Controller’s PC Interface 
(PCI). The configuration is used to define the input devices to be 
connected to the Safety Controller and to establish relationships 
between those input devices and the Safety Controller outputs.   

IMPORTANT: This tutorial is not intended to provide a 
comprehensive lesson about every feature the Safety Controller 
and PCI offer. Rather, it is designed to provide the basic skills 
and processes needed to explore the features on your own. 
It also is not intended to explain the operation of the Safety 
Controller. For complete operational instructions, read Sections 
1–8 of this manual.

 PC Interface (PCI) Configuration Tutorial 

1  Install the PC Interface Software 

• Insert the Banner Safety Controller CD.

• Select Install PC Interface program. 

The menu choices identify where the software will be installed 
on your computer; in most cases, this location does not need to 
be changed and Next should be selected. To install the software 
in a different location, select Browse and choose the location to 
install the software. When the location is selected, click Next.

• �Restart the PC for the PCI program installation to be complete.

2  Open the PC Interface Program

To open the PCI,

• Double-click on the  icon created on your desktop

-or - 

• �Select the following series of menu options: 
Start → Programs → Banner Engineering → Banner 
Safety Controller

• �Read and understand the warning on the Start-up Page and 
click OK.
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3 � Interface Elements: Tool Bar, I/O Property Files and 
Documents

The Main screen will appear on the computer when the 
application launches. You will be using the functions in each 
section of the window during this tutorial.

I/O Properties 
Double-click to access 

property settings.

Tool Bar

Documents 
Section

4  Documents 		

The Wiring Diagram shown in the screen shows its numbered 
terminals:

 S1 through S22 for input devices (both safety and non-safety)

 A1 for +24V dc and A2 for 0V dc

 O1 through O10 for Controller and I/O status indication

 �SO1 (1A and 1B), SO2 (2A and 2B) and SO3 (3A and 3B) for 
connections to the Safety Outputs

 �SR, the Controller’s system reset terminal (shown with a push 
button symbol) 

• �Click on the Ladder Logic Diagram tab just above the Wiring 
Diagram. No logic circuit elements are in place yet. 

• �Click on the Configuration Summary tab just next to the 
Ladder Logic Diagram tab. Only some default system settings 
are visible. 

The diagrams and the configuration summary will take form as 
the configuration develops.

Figure 1. PCI main screen, ready for configuration
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5  Create a Configuration

• �Click on the System Settings icon  on the right-hand 
side of the tool bar. 

The pop-up System Settings menu will appear.

• �Name the configuration file CFG1. (Up to 16 alphanumeric 
characters may be used.)

• �Add your name in the Author’s name box. (Up to 10 
alphanumeric characters may be used; abbreviate as needed.)

• Keep the default settings listed below.

 Power up mode: Normal

 Mute on power up: No check mark

 Monitored system reset: �Check mark (click on the checkbox 
to select or deselect it.)

Your System Settings menu should look like this:

• Click OK.

Add an E-Stop Button Input
• �Click on the Wiring Diagram tab, if the wiring diagram is not 

already displayed on the screen.

• �Click on the Add Safety Input button in the center of the tool 
bar. The Add Safety Input Device pop-up menu will appear. 

Select Emergency Stop Button Properties
• �Double-click on the Emergency Stop icon  in the Add 

Safety Input device menu. The ES01 Properties menu will 
appear. (Abbreviated, sequentially numbered device names are 
automatically assigned but can be changed.)

• Name: Keep ES01.

• Circuit type: �Keep the Dual-channel, 4-terminal. (Use the 
drop-down Circuit Type field to see other circuit 
options.)

• Reset logic: Keep the default Manual.

• Map to: �Keep the ES01 mapped to all three Safety Outputs 
(SO1, SO2, SO3). 

• Click OK.

Because a manual reset signal was chosen for the E-stop button, 
when OK is selected and the ES01 Properties menu closes, the 
RS01 Properties Manual Reset screen will appear automatically. 

Helpful Hint: If you want to 
access more information about 
a device and which circuit types 
provide what level of safety, 
click on the Info button. It will 
immediately bring up the section 
from Appendix A of this manual 
that provides that information for 
the displayed input device. 
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Manual Reset

The RS01 Properties menu appears.

• Change the Circuit type to Single-channel, 2-terminal.

• Click OK.

This single “common” manual reset signal will reset all of the 
Safety Outputs. (For the purposes of this tutorial, one common 
manual reset signal is used to reset all of the Safety Outputs. 
In a real application, it is possible to assign a separate reset for 
each Safety Output, if needed. To do this, choose the Circuit 
Type from the Reset Properties menu, and then select the 
Safety Output that the reset device should reset. Individual 
Reset Properties menus will appear until all Safety Outputs that 
are controlled by an input device with manual reset have a reset 
assigned.)

Your Wiring Diagram should look like this:

Your Ladder Logic Diagram should look like this:
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Add Other Safety Input Devices
The steps required to add other safety input devices are 
similar to those described above. Add a Gate Switch to the 
configuration:

• Click on the Add Safety Input button on the tool bar. 

• Double-click on the Gate Switch icon.

• �Create a Gate Switch configuration with the properties listed 
below.

 Name: GS01 

 Circuit: Single-channel, 2 terminals 

 Reset: Automatic

 Terminals: S5 and S6 

 Map to: �SO1 and SO2 
(Click on a checkbox to select or deselect it.)

Your Gate Switch properties menu should match the one shown 
above.

• Click OK.

Add a Two-Hand Control Input Device
• Click on Add Safety Input.

• Double-click on the Two-Hand Control icon.

• �Create a Two-Hand Control configuration with the properties 
listed below.

 Name: THC01

 Circuit: 2X complementary, PNP switch 

 Terminals: S7, S8, S9 and S10

 Map to: SO3

• Click OK.

NOTE: �The reset logic is set to Automatic for Two-Hand Control 
devices. There are no other reset options.

Add an Optical Sensor Input Device
• Click on Add Safety Input.

• Double-click on the Optical Sensor icon.

• �Create an Optical Sensor configuration with the properties 
listed below.

 Name: OS01

 Circuit: Dual Channel, PNP switch 

 Reset: Automatic

 Terminals: �S11 and S12 (Use the drop-down terminal number 
fields to change the terminal assignment, if 
needed.)

 Map to: SO1 and SO2

• Click OK.
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Add a Mute Sensor Pair
• Click on Add Safety Input.

• Double-click the Mute Sensor icon.

• �Create a Mute Sensor configuration with the properties listed 
below.

 Name: M1+M2

 Circuit: Dual-Channel, 4 Terminal 

 Terminals: �S13, S14, S15, and S16 
(Use the drop-down terminal number fields to 
change the terminal assignment, if needed.)

 Map to: OS01

 Time limit: 1 minute, 0 second

• Click OK.

NOTE: �Mute sensors are mapped to the safety input devices that 
they mute and not to the Safety Outputs. 

Add an External Device Monitoring Input
• Click on Add Safety Input.

• Double-click the External Device Monitoring icon.

• �Create an External Device Monitoring configuration with the 
properties listed below.

 Name: EDM01

 Circuit: Single Channel, 1 terminal

 Reset: Automatic

 Terminals: �S17 (Use the drop-down terminal number field to 
change the terminal assignment, if needed.)

 Map to: SO1

• Click OK.

Add More External Device Monitoring Inputs
Add two more External Device Monitoring inputs, one for each 
Safety Output.

• Name them EDM02 and EDM03.

• Use Single-Channel, 1-terminal circuit types for each.

• Assign terminal S18 to EDM02 and terminal S19 to EDM03.

• Map EDM02 to SO2 and EDM03 to SO3.
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Add a Status Output
• �Click on the Status Output button  in the tool bar (or 

double-left click on the O1 icon in the properties field of the 
screen).

 �The O1 Properties pop-up menu will appear. 

• Configure status output O1 with the properties listed below.

 Name: ES01

 Function: Track input 

 A drop-down Source field will now appear.

 Source: ES01

 Signal Convention: 24V dc = Run

 (When ES01 is in the Run state, O1 will be at 24V dc.  
 When ES01 is in the Stop state, O1 will be at 0V dc.) 

• Click OK.
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Add Another Status Output
• Select Status Output O2

• Configure Status Output O2 with the properties listed below.

 Name: Need Reset

 Function: Output waiting for Reset

 Source: SO1

 Signal Convention: 24V dc = Reset needed

• Click OK.

The Wiring Diagram should now look like this:

The Ladder Logic Diagram should now look like this:
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6 Configuration Confirmation

You will need to confirm this new configuration before it can be 
used in a safeguarding application. To do this you will need to 
connect the Safety Controller to your computer, using the USB 
cable. The confirmation process has two parts: 

1. �The Safety Controller microcontrollers receive and check 
a copy of the configuration to be sure that all safety critical 
settings are appropriate (configuration validation).

2. �The Controller sends a copy of the configuration back to the 
PC Interface for the final, manual confirmation check process 
(configuration verification).

To confirm CFG1, follow the steps below.

• Save CFG1

• �Connect the Safety Controller to the PC using the USB cable 
(refer to Section 1.3.1.)

• Apply 24V dc power to the Controller.

When the powered Controller is connected,  the Receive, Send 
and Confirm buttons in the PCI tool bar become 
active and turn from gray scale to full color.

• Click on the Confirm button. 

A message will appear, asking if you want to save a copy of the 
Controller’s existing configuration. 

NOTE: �The Controller used during the confirmation process may 
have an existing (either factory default or user-defined) 
configuration. Any configuration already loaded in the 
Controller will be overwritten (and therefore lost) during 
this confirmation process. It is the user’s responsibility 
to save existing configurations, as needed.

• �Select Yes to save the configuration or No to proceed to 
overwrite the Controller’s existing Configuration.

• �Enter the password (the factory default is 0000) on the Confirm 
Configuration pop-up menu.

• Click OK.

• �A pop-up warning message will ask if you want to continue; 
select Yes.

The configuration validation process takes a few seconds and 
when complete, the verification window appears.

• �Review the properties in the right column to be sure that they 
match the properties in the left column. 

 �If any device properties need to be changed, see Edit the 
Configuration at the end of this section (page 110).

 If both columns match, select Confirm for each device.

The confirmation screen shows the summary that is created 
when you have completed verifying each property.

As each device is confirmed, the Device Properties window for 
that device will compress, eventually showing only a checklist.

• �To review a confirmed device property, click on the checkbox 
and the Device Properties window for that device will expand.

• When the manual verification is complete, click OK. 

• �The Controller requires a system reset (or cycle power) to enter 
Run mode. 

• �Because the two-hand control (THC) inputs are not connected, 
the Controller will enter Lockout mode (the Controller’s Status 
indicator will be flashing red and the front panel display will 
indicate “ES01: Stop” and then “THC01: Fault”, on line 5 for 
SO3.



 12      P/N 154613 Rev. C

Banner Engineering Corp. • Minneapolis, U.S.A.
www.bannerengineering.com  •  Tel: 763.544.3164

SC22-3 and SC22-3E Safety Controller 
 Configuration Tutorial

PCI Tutorial

Edit the Configuration
• If there is a need to edit one of the properties during the 
confirmation process, select Edit.

• �Selecting the Edit button will open up the Properties menu for 
the device. Make the change and then select OK.

 �If you change one or more device properties during 
the manual verification stage of the confirmation, the 
Controller will need to re-validate the code. 

• �When you complete the edit and select OK, a message will 
appear asking whether you want to proceed to edit any other 
devices or if you want to restart the confirmation process.

When the configuration is successfully confirmed, the Controller 
will switch to Run mode, as described earlier, and wait for a 
system reset.

7 Other Functions

Receive a Configuration from the Controller (see Section 4.5.1)
To receive (upload) a configuration from a Controller and display 
it in the PCI:

• �Connect the Safety Controller to the PC using the USB cable 
(see Section 1.3.1.).  

• Apply 24V dc power to the Controller.

• Click on the Receive button in the tool bar. 

Send a Configuration to the Controller (see Section 4.5.2)
To send (download) a configuration from the PCI to a Controller:

• �Connect the Safety Controller to the PC using the USB cable 
(see Section 1.3.1.).

• Apply 24V dc power to the Controller.

• �Click on the Open button in the tool bar and open the intended 
configuration file.

• Click on the Send button in the tool bar.  

NOTE: �Confirming a configuration also sends the configuration 
to the Controller.

Open a Configuration from the XM Card (see Section 4.5.3)
To open a copy of a configuration from the XM card and display it 
in the PCI:
• �Connect the SC-XMP programming tool to the PC using the 

USB cable (see Section 1.3.1).

• Insert the XM card into the programming tool.

• Open the File menu in the upper left of the PCI tool bar.

• Select Open From XM Card.

A message will appear when the operation is complete.

NOTE: �Both confirmed and unconfirmed configurations can be 
sent to or received from the XM card.

Send a Configuration to the XM Card (see Section 4.5.4)
To send a copy of a configuration from the PCI to the XM card:

• �Connect the SC-XMP programming tool to the PC using the 
USB cable (see Section 1.3.1).

• Insert the XM card into the programming tool.

• �Click on the Open button  in the PCI tool bar and open 
the intended configuration file.

• Open the File menu in the upper left of the PCI tool bar.

• Select Send To XM Card.

A message will appear when the operation is complete.

NOTE: �Both confirmed and unconfirmed configurations can be 
sent to or received from the XM card.

Lock the XM Card (see Section 4.5.5)
To Lock the XM card so that the stored configuration cannot be 
changed (this operation cannot be undone):

• Insert the XM card into the programming tool.

• �Click on the Open button  in the PCI tool bar and open 
the intended configuration file.

• Verify that the correct file is stored on the XM card.

• Open the File menu in the upper left of the PCI tool bar.

• Select Lock XM Card.

A message will appear when the operation is complete. 

Change the Controller Password (see Section 4.5.6)
To change a Controller password from the PCI:
• Connect the Controller to the PC, using the USB cable.	

• Apply 24V dc power to the Controller.

• Open the File menu in the upper left of the PCI tool bar.

• Select Change Safety Controller Password.

• Fill in the menu that will appear as needed.

• Record the new password and click OK.
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Export Documents (see Section 4.5.7)
The configuration wiring diagram, ladder logic diagram and 
configuration summary documents can be saved as either .pdf or 
.dxf files. The additional network tabs can be saved as .pdf, .dxf, 
or .csv files.

To export a configuration file:

• Open the configuration file that you want to save.

• Open the File menu in the upper left of the PCI tool bar.

• Select Export. 

• Select the configuration document to export. 

• �Verify that the file name is correct and select the appropriate 
Save as type file option from the drop-down field (either .pdf 
or.dxf file format).

• Click <Done>.

Print Options (see Section 4.5.8)
To print a configuration file:

• Open the configuration file that you want to print

• Open the File menu in the upper left of the PCI tool bar.

• Select Print. 

• �Select the configuration document you want to print. A page 
setup menu will appear.

• Make the page and printer choices and click OK. 

Fault Log
To access the Controller’s internal Fault Log using the PCI:

• Connect the Safety Controller to the PC using the USB cable.

• Apply 24V dc power to the Controller.

• Open the View menu in the PCI tool bar.

• Select Fault Log.

The Fault Log screen will appear and will display any I/O or 
system faults detected by the Safety Controller.

Scheduled Fault Log Capture 
Controller I/O and system fault information can be recorded to a 
computer file. To set up a recording period to capture fault data 
from a Controller, access the Fault Log menu.

• Connect the Safety Controller to the PC using the USB cable.

• Apply 24V dc power to the Controller.

• Open the View menu in the tool bar.

• Select Fault Log. 

• Select the Edit button. 

• Set the Start and End times, using the drop-down fields.

• Browse for the File location. 

• Click OK.

The fault data will be stored to this file location as an Excel file.
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Live Display
To access live Controller information from the PCI:

• Connect the Safety Controller to the PC using the USB cable.

• Apply 24V dc power to the Controller.

• �Click on the Live Display button  in the tool bar or open 

View > Live Display.

The Live Display screen will appear.
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The Safety Controller Onboard User Interface (OBI) is a tool 
for creating and managing configuration files for the Safety 
Controller, using the built-in features of the Controller itself. 
The OBI is also used to retrieve, display and store both I/O and 
system status and fault information. Ethernet configuration can 
be viewed using the OBI, but cannot be configured using this 
interface. 

The following tutorial explains the steps needed to create a 
sample configuration, using the Safety Controller’s Onboard 
Interface (OBI). The configuration is used to define the input 
devices to be connected to the Safety Controller and to establish 
relationships between those input devices and the Safety 
Controller outputs.

Important: This tutorial is not intended to provide a 
comprehensive lesson about every feature the Safety Controller 
and OBI offer. Rather, it is designed to provide the basic skills 
and processes needed to explore the features on your own. It 
also is not intended to cover the operational requirements of the 
Safety Controller. For complete operational instructions, read 
Sections 1–8 of this manual.

Enter Configuration Mode
The first step in creating a configuration is entering Configuration 
mode. To enter Configuration mode from the Run mode display, 
press OK to display the main System Menu. At the System 
Menu, press the Down arrow button until Configuration Mode is 
highlighted on the display, then press OK.

Enter Password
The default password is 0000. Use the left/right arrow keys to 
select the password digit to change. Use the up/down arrow 
buttons to change the selected password digit.

When the password is entered, press OK to enter Configuration 
mode.

Read the caution that the Safety Outputs will turn OFF when 
Configuration mode is entered, and press OK.

Onboard Interface (OBI) Configuration Tutorial 

Edit Configuration
To edit the configuration from the Configuration Mode menu, 
select Configuration File and press OK.

When the Configuration File menu is displayed, select Edit 
Configuration and press OK.

The first property of the configuration that can be changed is its 
name.

Use the left/right arrow keys to select the character to be 
changed (up to 16 characters).

Use the up/down arrow keys to change the character (choices A-
Z, 0-9, -, +, or space), and press OK.

Add Input Devices
In this tutorial we will add the following input devices:

• Emergency stop (E-stop) input

• Gate switch input

• Two-hand control input

• Reset input

• Optical sensor input

• External device monitoring inputs

• Mute sensor pair input

NOTE: �Safety mat, protective stop, rope pull, enabling device, 
and bypass switch devces are not covered in this 
tutorial.
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Add E-Stop Input
To add the E-stop input, select Inputs in the following menu and 
press OK.

Select Add Input and press OK.

NOTE: �The other options in this menu, Delete Input and Edit 
Input, are not covered in this tutorial. These selections 
allow you to make changes to an existing configuration.

Input devices are categorized as either safety inputs or non-
safety inputs. The E-stop button is categorized as a safety input. 
Select Safety Input and press OK.

The next menu is used to select the type of input device to add. 
Icons for the input types are used to make the selection easier. 
Use the left/right arrow keys to select the type of input to add, in 
this case use the E-Stop icon, and press OK.

Configuring Input Device Properties
The following parameters must be configured for each E-stop 
input device:

• Name

• Circuit type

• Terminal assignments

• Advanced settings

• Reset logic

• Output mapping

Enter Input Device Name
After selecting to add an E-Stop Input device the next menu 
displayed is the Enter Name menu.

Use the left/right arrow keys to select the character to be 
changed, up to 10 characters.

Use the up/down arrow keys to change the character (choices 
A-Z, 0-9, -, +, or space).

In this case, the name of the E-Stop Input was set to the default 
value of ES01. Do not change the name of the device at this 
time; just press OK. 

Input Properties Menu
The next menu displayed is the Input Properties menu. 

Set the Circuit Type of the Input
From the Input Properties menu select Select Circuit Type and 
press OK.

The display will show the Select Circuit Type menu. 

The left/right arrow keys select the circuit type of the input 
device. Select the circuit type Dual Ch., 4 terminal and press 
OK.

When the circuit type is selected, the display returns to the Input 
Properties menu.

Edit the Terminal Assignments
When the input circuit type was selected, the Safety Controller 
automatically assigns terminals for the input device. These 
terminal assignments can be viewed and changed by selecting 
Edit Terminals and pressing OK.
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Use the left/right arrow keys to select the terminal assignment to 
be changed.

Use the up/down arrow keys to change the terminal 
assignments.

Set the terminal assignments to S1, S2, S3, and S4, and press 
OK.

After the terminal assignments are edited, the display returns to 
the Input Properties menu.

Map Outputs
Choose which of the Safety Output(s) the input will control. 
Select Map Outputs in the Input Properties menu and press OK.

To map the input to an output, select the output using the up/
down arrow keys and press OK. A filled-in circle next to an 
output indicates the input is mapped to that output. To remove 
the input mapping, select the output and press OK. An open 
circle indicates the input is not mapped to that output.

Map the E-stop to all three Safety Outputs, select Save and 
press OK. 

After mapping the input to the Safety Outputs, the display returns 
to the Input Properties menu.

Set Reset Logic
To set the reset logic, select Reset Logic and press OK.

Use the left/right arrow keys to select the Set Reset Logic 
parameter. Select Manual and press OK.

After the Reset Logic parameter is set, the display returns to the 
Input Properties menu.

Saving the Input Device Parameters
All of the E-Stop’s parameters have been set. To save the 
parameters, select < Done > and press OK.

The display now indicates the input parameters were saved.

Press OK to continue.

The display returns to the Inputs menu.
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Adding Other Input Devices
The steps required to add other input devices are similar to 
those you’ve just completed.

Now create the following input devices, with properties as 
provided in the steps below:

• Gate Switch, GS01

• Two Hand Control, THC01

• Reset Input, RS01

• Optical Sensor, OS01

• External Device Monitors; EDM01, EDM02, and EDM03

• Mute Sensor Pair, M1+M2

Safety Input: Gate Switch – GS01

Circuit Type: 
Single-Channel, 
2-Terminal Contact Switch

Terminals: S5 and S6

Mapped to: SO1, SO2

Automatic Reset Logic

Safety Input: Two-Hand Control – THC01

Circuit Type: 
2X complementary, 
PNP switch

Terminals: 
S7, S8, S9, and S10

Mapped to: SO3

Non-Safety Input: Reset Input – RS01

Circuit Type: 
Single Channel, 
2-Terminal Contact Switch

Terminals: S21 and S22

Mapped to: 
SO1, SO2, and SO3

Safety Input: Optical Sensor – OS01

Circuit Type: 
Dual-Channel, PNP

Terminals: S11and S12

Mapped to: SO1and SO2

Automatic Reset Logic

Safety Input: Mute Sensor – M1 + M2

The next input is a little different than the previous inputs 
added. So, we’ll discuss this one in a little more detail.

After selecting to add a mute sensor and entering its 
name, set the circuit type and the terminal assignments 
as follows:

Circuit Type: 
Dual-Channel Contact Switch

Terminals: �13, 14, 15 and 
16

Instead of mapping to an output, mute sensor inputs are 
mapped to the inputs they will mute. Only certain types of input 
devices can be muted. The Safety Controller creates a list of the 
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inputs in the current configuration that can be muted. Select Map 
Inputs from the Mute Sensor Properties menu and press OK.

Using the up/down arrow buttons, select OS01 from the list of 
inputs and press OK. The circle to the left of the OS01 fills in to 
indicate that mute senor pair M1+M2 is mapped to OS01. 

NOTE: �In this case, the mute sensor pair is being mapped to 
only OS01, but the mute sensor pair can be mapped to 
more than one input.

Select Save and press OK to complete the input mapping 
process.

Set the Mute Time Limit
The mute time limit defines the maximum amount of time an 
input can be muted. From the Mute Sensor Properties menu, 
select Set Mute Limit Timers and press OK.

When the next menu is displayed, press OK to display the Mute 
Time Limit Enable menu.

Using the up/down arrow buttons, select Change Time… and 
press OK.

 

NOTE: �If the box in front of Enable Time Limit is not checked, 
select Enable Time Limit and press OK to enable the 
time limit. 

Change the mute time limit to 1 minute. Use the left/right arrows 
to select the digit to be changed and the up/down arrows to 
change the digit (0-9) and press OK.

At the Mute Time Limit Enable menu, select <Done> and press 
OK.

At the Mute Sensor properties menu, select <Done> and press 
OK to complete adding the mute sensor. 

Safety Input: External Device Monitor – EDM01

Circuit Type: 
Single-Channel, 1 Terminal

Terminal: S17

Mapped to: SO1

Safety Input: External Device Monitor – EDM02

Circuit Type: 
Single-Channel, 1 Terminal

Terminal: S18

Mapped to: SO2

Safety Input: External Device Monitor – EDM03

Circuit Type: 
Single-Channel, 1 Terminal

Terminal: S19 

Mapped to: SO3

All inputs have been added; press OK. When the Inputs menu 
is displayed, press ESC to display the Edit Configuration menu 
(see next page).
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Edit Inputs menu

ESC→

Edit Configuration menu

Configure the Status Outputs
To configure the Status Outputs, select Outputs/System 
Settings and press OK.

Using the left/right arrow keys, select Track Input and press OK.Select Status Outputs and press OK.

Use the left/right arrow keys to select the Status Output to 
configure. In this case, select Status Output 01 and press OK.

The next menu displayed is the Status Output Properties 
menu. From this menu you can configure the Status Output(s). 
Configure:

• Status Output 01 to track the state of ES01

• �Status Output 02 to signal when a reset operation is needed 
for Safety Output SO1

Configure Status Output 01
Change the name of 01 by selecting Change Name and 
pressing OK.

Use the left/right arrow keys to select the character to be 
changed (up to 10 characters).

Use the up/down arrow keys to change the character (choices 
A-Z, 0-9, -, +, or space).

Set the name to ES01 and press OK.

The display returns to the Status Output Properties menu. The 
top line of the display now displays the name assigned to the 
Status Output.

Configure the Status Output to track an input. Select Select 
Function and press OK.

The display returns to the Status Output Properties menu.

Configure the Status Output to track the E-stop input, ES01. 
Select Select Source and press OK.

Using the left/right arrow keys, select ES01 and press OK.

The display returns to the Status Output Properties menu.

Status Output 01 is now configured. To save the settings, select 
<Done> and press OK.

The display returns to Outputs/System Settings menu.

To configure additional Status Outputs, select Status Outputs, 
select the Status Output to configure and repeat the steps that 
were performed for Status Output 01.



P/N 154613 Rev. C      21

Banner Engineering Corp. • Minneapolis, U.S.A.
www.bannerengineering.com  •  Tel: 763.544.3164

SC22-3 and SC22-3E Safety Controller 

Configuration Tutorial
OBI Tutorial

When the last Status Output has been configured, return to the 
Edit Configuration menu by pressing ESC.

Review the Configuration
Prior to saving the newly created configuration, review it by 
selecting Configuration Summary and pressing OK.

Configure Status Output 02

Name: NEED RESET

Function:

Source:

The Configuration Summary menu allows you to:

• �Review the input circuit and terminal assignments for each 
input

• Review the mapping assignments of each input

• Review the configuration of each Status Output

Review Terminal Assignments
Select Terminal Assignments and press OK.

Edit Inputs menu

ESC→

Edit Configuration menu

The display shows the terminal assignments for the first input. 
Use the left/right arrow keys to view the terminal assignments for 
the other inputs. 

When finished, press either OK or ESC.

Review Input/Output Mapping
Select Input/Output Mapping and press OK.

The display shows the input/output mapping for the first input. Use 
the left/right arrow keys to view the other inputs. 

When finished, press either OK or ESC.

Review Status Output Settings
Select Status Output Settings and press OK.

The display shows the first Status Output. Use the left/right arrow 
keys to view the other Status Outputs.

When finished, press either OK or ESC.

When finished reviewing the configuration summary, return to the 
Edit Configuration menu by pressing ESC.
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Saving the Configuration
Up until now, the configuration changes have been stored in a 
temporary memory location. To make the configuration changes 
permanent, select Save Configuration and press OK.

NOTE: �If you do not want to save the changes while at the Edit 
Configuration menu, press ESC and select Yes when 
asked if you want to exit without saving changes.

Once the configuration is saved, the display will return to the 
Configuration Mode menu.

Confirming the Configuration
You will need to confirm the changes to the configuration before 
it can be used in a safeguarding application. To confirm the 
configuration, select Confirm Configuration and press OK.

The Confirm Configuration menu will appear.

To confirm you’ll need to review the safety-critical configurations 
for the inputs, Safety Outputs, and the system settings. An 
unchecked box in the Confirm Configuration menu indicates the 
safety-critical settings have not yet been confirmed.

Confirm Configurations of Inputs
From the Confirm Configuration menu, select Inputs and press 
OK.

The next menu lists all of the safety inputs in the configuration.

To confirm E-Stop ES01, select it and press OK.

The next series of menus lists the safety-critical configurations 
for this input. Press OK after reviewing each setting.

Repeat the confirmation process for each of the inputs.

When all inputs have been confirmed, the display looks like this:

To continue confirming the configuration, select <Done> and 
press OK.
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Confirm Safety Output Configuration
Select Safety Outputs and press OK.

To confirm Safety Output SO1’s configuration,  select SO1 and 
press OK.

The next series of menus lists the safety-critical configurations 
for SO1. Press OK after reviewing each setting.

When SO1 is confirmed, the box in front of SO1 will be checked.

Repeat the confirmation process for SO2 and SO3.

When finished, the Confirm Outputs screen should look like this:

Select < Done > and press OK.

The Confirm Configuration menu now indicates the Inputs and 
Safety Outputs are confirmed.

The last step is to confirm the System Settings. Select System 
Settings and press OK.

The Safety Controller has now been configured. The display 
screen should be similar to the one below, if the inputs have 
been connected. 

NOTE: �If the inputs have not been connected, the Controller will 
indicate a lockout.

Exit Configuration Mode
Select Exit Configuration Mode and press OK to exit 
Configuration mode and return to the Run mode display.

The next series of menus lists the safety-critical system settings. 
Press OK after reviewing each setting.

Final Confirmation Step
All of the safety-critical configurations settings have been 
confirmed and the configuration can be used in a safeguarding 
application. If any changes are made to the configuration, the 
confirmation process will need to be repeated.

Exit the Confirm Configuration menu by selecting < Done > and 
pressing OK.
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